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Introduction
Congratulations on being one of the first owners of
the exciting new Meridian 861!
We are very proud of the 861, it has been designed to
give the very highest sound quality in a wide range of
systems and to provide playback for all the sound
formats currently available.

The technology in 861 is the most advanced; it is
also designed to be flexible in the future. The card-
based construction and use of flash memory for the
built-in software mean that we expect to be able to
keep your system up to date, or to evolve as your
requirements change.

861 Documentation
This 861 is so new that the full System Guide is not
available. However, the Meridian 800 Series dealers
are fully trained in Meridian surround systems.

This sheet supplements your 861 User Guide and
provides some items you or your dealer need to be
aware of.

Most of the information in this sheet will be in the 861
System Guide when it is available.  Please return the
enclosed form to register your 861 purchase. We will
send you the System Guide with any updates as soon
as it is ready.

861 Built-in software
The 861 is a very advanced audio computer. The
software that controls 861 and the DSP programs that
process and decode the audio are held in a re-
programmable ‘flash’ memory.

At any time the software inside 861 can be updated
by connecting the 861 to either a personal or laptop
computer – more details are given later in this
supplement.

It is Meridian’s intention to make appropriate software
updates available through its support network.

Software updates may be necessary to allow the
addition of new cards, new DSP functions, to expand
functionality of the whole installation or to correct minor
bugs under warranty.

We recommend that you take the dealer’s advice
about whether or not updates are appropriate to your
application.

861 Set-up software
The 861 is a sophisticated device that offers a very
large number of options to the installer – and therefore
a very strong likelihood of excellent all-round
performance in a wide range of applications.

Because there are so many things that can be
customised in an 861, we have chosen to use a
computer to assist in setup.

The Meridian 861 setup program is an exciting
departure for high-end audio. The advantages of this
approach become obvious as the setup proceeds –
and in particular in the way the setups can be stored
either as User Types or as computer files for backup.

THX approval
It is customary for all products incorporating THX
technology to be fully evaluated by Lucasfilm. This
process allows all parties to ensure that the intricacies
of the surround controller are as expected.

The 861 is a very complex unit, being one of the first
controllers offering THX with DTS and the very first to
offer THX with MPEG audio.

This has caused some delays in the final THX
approval for 861 which is not yet complete.

Lucasfilm have kindly allowed us to proceed with
manufacture of 861 while they complete their testing.

Meridian obviously believes that the version of 861
software loaded in your 861 meets the THX
requirements. In the event that any changes are
necessary, we will immediately issue a software update
to you or your dealer. Please be sure that you return
the enclosed form so we can inform you on this.

Types and User Types
All Meridian products use the Type method of resetting
the product back to one of several pre-programmed
factory configurations.

Typing the product clears all settings you may have
made in Calibration or by using the 861 Store or Assign
keys. Typing also re-inserts a suite of previously stored
settings or factory default settings. These settings can
cover a large variety of things – ranging from input and
output assignments, to detailed menu settings for each
format + source combination.

To learn how to use Type, please refer to the 861
User Guide.

If you do not want to lose all the settings in your 861,
they can be first stored as a file in a computer using
the 861 setup program described later.

Your dealer may have created one or more User
Types for you. The advantage of this is that you or the
dealer can rapidly switch between a number of pre-
determined options during installation, and you can
have the security of being able to restore the dealer’s
settings at any time. User Types are created and
installed using the 861 setup program.

Labeling
The back panel of each 800 Series card typically has
the inputs and output sockets numbered, for example
as D1, D2 etc. Beside each socket there is a white
label area in which you can write the assignment in a
way that helps you remember which is which.

The 861 is supplied with a number of self-adhesive
pre-printed labels so that the inputs and outputs can be
neatly marked to avoid writing on the product itself.

Taking time to fix the labels will help a great deal in
the future – especially if you have more than one card
of the same kind.

The labels can also be safely removed and changed
at a later date.
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Standard input connections
A standard 861 is fitted with:

• One analogue input card IA00 with inputs labeled
A1 through A6.

• One digital input card ID10 with inputs labeled D1
through D6, O1 and O2.

Later 861s may also be fitted with an optional card:

• One Video switching card VS00 with inputs
labeled V1 to V4 and S1 to S4.

The factory Type settings give a standard assignment
of these inputs which is described in the table below.
These assignments may already be suitable to your
needs.

Source Audio In Video In

CD D1 Last Valid

Radio A2 Last Valid

LP A1 Last Valid

TV A3 V2

Tape 1 A4 Last Valid

Tape 2 D4 Last Valid

CDR D3 Last Valid

Cable O2 S3

DVD D2 S1

VCR1 A5 V1

VCR2 A6 S4

LDisc O1 S2

If any other optional input cards are fitted, they are not
accessed as part of the standard Types and the 861
will need to be configured to use them.

Standard output connections
Analogue systems
A standard analogue system uses two OA00 analogue
output cards. These cards are probably pre-labeled #1
and #2. OA00 #1 (nearer the centre of 861) has the
master oscillators engaged and is used for the front
channels.

Digital Theatre
A standard Meridian Digital Theatre uses an OD10
digital output card. At this time there should not be
more than one of these fitted. For additional
subwoofers, or mixed installations one analogue output
card OA00 will be used. The connections in these
cases are given in the following tables.

Analogue speakers

Speaker Output

Left Main OA00 #1:  1

Right Main OA00 #1:  2

Centre OA00 #1:  3

Subwoofer OA00 #1:  4

Left Side OA00 #2:  1

Right Side OA00 #2:  2

Left Rear OA00 #2:  3

Right Rear OA00 #2:  4

Digital speakers

Speaker Output

Left Main OD10 #1:  1/2

Right Main OD10 #1:  1/2

Centre OD10 #1:  3/4

Subwoofer OA00 #1:  4

Left Side OD10 #1:  5/6

Right Side OD10 #1:  5/6

Left Rear OD10 #1:  7/8

Right Rear OD10 #1:  7/8

Connecting a Theatre System
For more details of connecting a Meridian Theatre
system, please refer in the interim to standard training
materials and/or the installation manuals for 519, 565
or the DSP speakers. Some of this material can be
found at Meridian’s website:
http://www.meridian-audio.com.

Configuring a Digital Theatre
Installers please note. The 861 has been designed to
be the default Controller in a Meridian Digital Theatre
system.
Therefore, when you do an Autoconfigure procedure
(press Clear in Standby) the 861 will become system
Controller and the Master Speaker will be set as Non-
controller.
This may not be what you prefer for infra-red control. In
such cases the system controller needs to be setup
manually.
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Using the 861 setup program
Overview
Setting up an 861 with the setup program is easy.

861 settings can be stored on disk and we have
included files containing settings corresponding to the
built-in Types (see 861 User Guide).

The best approach is to start with a standard settings
file that most closely matches your system. If you have
used the setup program before, you may have a
settings file of your own to start from.

Typically you would follow these steps:

1. Run the setup program, MERIDIAN.EXE. (See
'Program installation' and 'Running the software'.)

2. Load the appropriate settings file. (See 'To load
settings from a disk'.)

3. Now alter the current settings of the product to suit
the planned installation. (See 'Using the Windows
95 program'.)

4. When you are happy with the settings, you can
store them in the product. (See 'To Store Settings
in the 861'.)

5. You can then calibrate the unit using its built-in
Calibration mode. (See 861 User Guide.)

6. After calibration, you can then load the fully
calibrated settings back to the program. (See 'To
extract the current settings'.)

7. If you wish, make a User Type for the settings so
that they can be restored using Type. (See 'To
Create a new User Type'.)

8. Add the Owner information in the ‘Owner’ section.
9. Store the Type and Owner information in the

product – (See 'To put User Types into flash
memory'.)

10. Finally, save the settings file to disk and keep it
carefully – it is a backup of all your settings. (See
'To save settings to a disk'.)

System requirements
To run the 861 setup program, you must have a
computer running Windows 95 or Windows NT 4.0.
The computer must have a spare serial port, capable of
running at 38400 baud. A suitable null-modem serial
cable is supplied.

Note : 861 internal software can be updated using a
program which only requires DOS and a serial port.
(See ‘The FUPLOAD program’.)

Program installation
The setup program may have arrived on a floppy disk
containing an installation routine or a self-extracting
.EXE  file with instructions. If the program has been
obtained over the Internet, then it will be in the form of
a self-extracting .EXE  file.

In the latter case, create a directory for the program
(e.g. C:\Meridian) and extract the files there. The
program will install itself automatically the first time it is
run.

Upgrading
If you are given an updated version of the program,
follow the instructions that come with it.

Uninstallation
The program may have come with an uninstall
program. Otherwise it can simply be deleted if no
longer required.

What the software package contains
The package will contain some of the following:

• MERIDIAN.EXE  – a windows-based application
that creates configurations, User Types and that
transfers settings between the computer, the
product, and files on disk. It can also install new
built-in software in the 861.

• FUPLOAD.EXE – a DOS program, which can also
install new built-in software in the 861.

• DEBUG.REG  – for advanced users only
• *.DLL   – various application extensions required

by MERIDIAN.EXE
• 861_xxx.MFU  – these files (if present) are

Meridian Flash Upload images, and contain built-in
software for the 861.

• *.MSF  – these are Meridian Settings Files and will
contain settings for the 861.

Overview of settings in the Meridian 861
There are two types of memory in the Meridian 861,
Flash and EEPROM. Flash memory holds information
which, on previous Meridian products could only be
altered by changing the EPROM. In 861 it can contain:

• Built-in operating software
• Owner information
• User Types.

The contents of the flash memory cannot be extracted
from the 861, and can only be written by a PC directly
connected to the 861.

EEPROM memory contains the current settings of
the product. Some of these settings can be altered
during normal operation, e.g. by creating a new preset
or assignment. It is the EEPROM contents that are
replaced by a pre-defined set when a product is Typed.

The current settings can be read and written by a PC
directly attached to the product via a serial lead. The
setup software allows the following operations:

• Upload of new built-in software into the flash
memory of the 861.

• Upload of new Owner information and User Types
into the flash memory of the 861.

• Storing modified current settings into the EEPROM
of the 861.

• Extracting the current settings from the EEPROM
of the 861.

Note: User Types cannot be extracted from the 861, so
remember to save User Type sets to disk as well as
uploading them into the 861!
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Running the software
To run the software double-click on the Meridian icon in
the installation directory.

The first time you run the software on a computer:
1. Go to the ‘View’ menu and select ‘Options...’
2. Chose the serial port you intend to use to

communication with the 861, e.g. COM1.
3. Click ‘OK’.

Once made, this setting will be remembered and only
needs changing if you want to use a different serial
port.

The setup program can also be started by double-
clicking an .MSF (Meridian Settings File) file.

To extract the current settings
You can extract the current settings from an attached
Meridian 861 so they can be edited or saved to disk.

1 Select ‘Fetch from products’ on the ‘File’ menu, or
click the ‘Fetch’ icon.

To load settings from a disk
You can load settings, User Types and owner
information from disk.

1 Select ‘Open’ on the ‘File’ menu, or click the
‘Open’ icon on the tool bar.

To save settings to a disk
To save the current settings, Owner information and
User Types to disk:

1 Select ‘Save’ or ‘Save As...’ from the ‘File’ menu,
as appropriate.

To create a new setup
To create a new setup from scratch:

• Select ‘New’ on the ‘File’ menu, or click the ‘New’
icon on the tool bar, or

• Open a Meridian settings file as a starting point
and save it with a new name.

To store settings in the 861
To store the program settings back to the product:

• Select ‘Store to products’ on the ‘File’ menu, or
• Click the ‘Store’ icon on the tool bar.

Using the Windows 95 program
Move around the 861's settings by clicking on icons in
the left-hand pane of the application. Clicking once on
an icon selects it and displays the corresponding
settings in the right-hand pane. Double-clicking on a
Product, Type, Current Settings or ‘Back’ icon opens it,
and the left-hand pane changes to display a set of
subsidiary icons – this works much like a directory
listing.

As you move around, the title bar reflects your
position in the settings. Settings in the right-hand pane
may be modified by clicking on them and typing a new
value or choosing from a list.

To create a new User Type
To create a new user type:

1 Select the left-hand pane icon for either ‘Current
settings’, or an existing Type (which can be used
as a starting point).

2 Hit the ‘Copy as new Type’ button on the toolbar.
This transfers the settings to the clipboard.

This creates a new Type that can be named in its right-
hand pane.

Note : If a Type icon is selected when you paste, then it
will be over-written. If a User Type is pasted over the
‘Current settings’ this is equivalent to Typing the
product.

To put User Types into flash memory
If you have created User Types in the setup program,
you can load the current User Types in the 861’s flash
memory. This overwrites any User Types currently in
861.

1 Click on the ‘Store’ icon or look in the ‘File’ menu
under ‘Store to products’.

2 Select ‘User Types and Owner information’

Advanced setup features
To save User Types to disk
If you have created User Types in the setup program,
you can save the current User Types to disk as an
.MFU file.

1 Select the ‘Owner’ icon for the product. Options for
handling User Types are presented in the
‘Advanced Tab’.

2 In the ‘User Types’ box, select ‘Save to Disk’

To update the 861 built-in software
To change the built-in operating software in the 861’s
flash memory:

1 Select the ‘Owner’ icon for the product. Options for
flash uploading are presented in the ‘Advanced’
tab.

2 In the ‘Product firmware’ box, select the correct .
.MFU file from the drop-down list. The list will show
all upload files starting with ‘861’ in the installation
directory. To select an upload that has a different
name, or is in a different directory, use the
‘Browse...’ button. Once the desired firmware has
been selected:

3 Click ‘Upload to product...’ in the ‘Product
firmware’ section.

Note:  It can take several minutes to update the
complete flash memory. In some circumstances
screen-savers interfere with serial communications.
We recommend that you disable or extend the time-out
of any screen-savers before trying to upload a file.
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The FUPLOAD program
The DOS-based FUPLOAD.EXE program can also be
used to load built-in software to the 861. This allows
the product to be updated with a less sophisticated
computer, and also gives support for circumstances in
which Windows communication problems may interfere
with an update from the setup program.
To use FUPLOAD, the syntax is:

FUPLOAD 861_xxx.MFU  /Cn

where 861_xxx.MFU  is the supplied file, and n is the
COM port to which the 861 is connected. Other, more
advanced, options are summarised by FUPLOAD /?

The 861 must be in Standby to communicate with the
PC. While it is being configured, it will say ‘Connected
to PC’ on its front-panel display.

Hints and tips for the setup program
• Do not run other applications that use the same

serial port as the Meridian application at the same
time. This may cause a loss of connectivity.
Quitting both applications and restarting should fix
the problem.

• The 861 must be in Standby to communicate with
the PC. If it is taken out of Standby (whether
directly, or using the Comms or MSR) the next
fetch or store operation may fail with a ‘No Current
Session’ error. The operation will normally
succeed if re-tried. If you intend to deliberately
bring the product out of standby while running the
setup application, use the ‘Disconnect products’
option beforehand.

• A maximum of 10 User Types can be uploaded
into a product.

• Each User Type uses 300k of RAM while being
edited. So, if a large number of types are being
edited, the computer must have sufficient memory.

• Editing of presets and card settings is not currently
supported by the application.

• By default, sources have the same names as the
MSR buttons that will select them. If a source
name is changed, the MSR legend is shown in
brackets after the name.

• Screen-savers. In some circumstances screen-
savers interfere with serial communications. We
recommend that you disable or extend the time-
out of any screen-savers before trying to upload a
file.

• If you copy settings over an existing Type, the
copied settings will not show up immediately. To
see the new settings, click on another Type and
then return. The settings will then be correct.

Advanced 861 settings
Settings with video
The 861 provides a LipSync feature to allow you to
delay the sound by up to one video frame.

Some installations require longer delays to
compensate for the delay in video processors. Video
processors like line-doublers may delay the picture by
up to 5 video frames – interfering significantly with the
sound/picture alignment. The 861 allows an overall
Delay setting to compensate for this.

To access this advanced setting:

• Select ‘List’ in the ‘View’ menu. This allows a tree-
listing of settings.

• In the left-hand pane, find the Meridian 861,
Current Settings, Setup branch.

• In the right-hand pane double-click ‘Delay’. Enter a
value up to 7 frames (30ms per frame).

Trigger outputs
The CO00 computer card in the 861 has three trigger

outputs that can be used to operate ‘Function Select’
or certain relays. They may  be used to trigger
amplifier, video or environmental changes.

The state of the three outputs are adjusted in the
setup program. Look under ‘Sources’; select a source
(e.g. CD) and click the ‘Advanced’ tab.

The trigger outputs each provide +12V nominal when
selected, 0V when de-selected. Each trigger can
supply up to 50mA.

Special settings for DTS
The 861 automatically detects DTS if you play a DTS
CD, LaserDisc or DVD. When the disc starts playing,
the 861 will switch to one of its DTS presets.

If you subsequently play a different disc – such as a
standard CD or a Dolby Digital LaserDisc – the 861 will
reload another DSP preset like Trifield or Dolby Digital
(AC-3).

Dolby Digital and MPEG are both ‘flagged’ as non-
audio in the incoming data stream and so devices like
861 or digital/analogue converters (DACs) know not to
play it as normal audio by mistake. (This same method
is used to prevent you playing back CDROMs as audio
in a CD player.) If, for any reason, compressed
streams are played as audio, the result is a loud hiss.

Like Dolby Digital and MPEG, DTS is a compressed
(non-PCM) signal. DTS streams on the other hand are
not flagged in this way; consequently normal DACs and
decoders have no direct method of preventing you
hearing the compressed stream as a loud hiss.

The Meridian 861 detects the DTS signal and
switches to a DTS preset as quickly as it can. However,
even the 861 needs a short time to be sure that this
really is DTS. So, when you play a DTS LaserDisc you
may hear the compressed signal as a short burst of
hiss before DTS is identified.  As we have explained,
this is an unavoidable limitation of the way DTS is
delivered, not of the 861. (See ‘DTS Delay’.)
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DTS Delay
In the setup program, look under ‘Sources’, select a
source (e.g. CD) and click the ‘Advanced’ tab. There is
an additional check-box that allows a short delay to be
added to the audio for that Source.

Clicking on the box selects it. When this setting is
stored in the 861 it will add a 32ms delay to the audio
for that source. This delay allows the 861 time to detect
a DTS signal before it is played out, and therefore
prevents the short hiss occurring as the disc starts
playing.

Setting DTS Delay is the ideal and recommended
solution to playing DTS from CD. This setting is not
necessarily recommended for video sources (such as
LaserDisc or DVD) because 32ms audio delay may
affect the Lipsync with the picture. It can be used in
conjunction with the delay setting described in the
‘Advanced settings with Video’ section.

When you Type the 861, the default settings apply
DTS Delay only to CD, Radio and CDR.

Diagnostic displays
The 861 can provide detailed information about its

current operation. You may be asked to use these
displays for fault-finding.

To turn Diagnostic displays on or off:

• In Standby, press and hold the Copy button for a
few seconds, or

• In the setup program, select Diagnostic displays
in Setup, Current Settings, Advanced.

When you use the Display key either on 861 or the
MSR (See 861 User Guide), three new displays can be
seen, as follows.

De-jittering diagnostics

The display looks like:

FIFO 83 TXU080251 00

These numbers may be requested by Meridian
Technical Support.

Input signal diagnostics

The display looks like:

DSP VEAC 5/1/00/1/22

Here, ‘V’ and ‘E’ are flags for Invalid and Emphasis. ‘A’
or ‘D’ indicate Audio or Data; ‘C’ or ‘P’ indicate Pro or
Consumer mode. The remaining numbers report status
and may be referred to by Meridian Technical Support.

Setup Diagnostics

This display gives a very useful confirmation that the
key output parameters are correctly set in the 861. The
display looks like:

Setup GBG.1/MMSASA/D

The first three letters list the speaker layouts that will
be used for Music, Theatre Layout and 5.1

The next part ‘.1’ or ‘Blank’ indicates an LFE
subwoofer.

The next section (between / and /) show the speaker
settings in the order Main fronts, Centre, Sides and
Rears.

The first two letters report the front speakers Main and
Centre as follows:

• M for Meridian DSP
• D for Digital
• A for Analogue

The last four letters report the surrounds as Sides then
Rears as follows:

• LA or SA for large or small Analogue
• LM or SM for large or small DSP
• LD or SD for large or small Digital

So, in the above example, the settings are for Meridian
DSP Left, Right and Centre used with small analogue
sides and rears.

The final entry ‘A’ or ‘D’ refers to the mode of the
master oscillators. If the front speakers are digital then
you should see a ‘D’, otherwise ‘A’.

Reporting
If you need to report a problem, please provide the
following information:
• Software version and date (select ‘About’ from the

‘Help’ menu).
• The computer hardware and operating system

version in use.
• The exact error message (if any) reported by the

861 or the setup program.
• Any messages displayed on the product.
• A .MSF file containing the settings you were

working on at the time.
• A description of what you think you did to cause

the problem.



Meridian 861 User Request

Please register your 861 with us. We can then send you a complete installation manual
when it is released. You can register in the following ways:
• Complete the details below and either mail or fax this sheet to Meridian Audio in the

UK or Meridian America in Atlanta.
• Register by email by sending the necessary information to list6@meridian-audio.com

Your name  ...........................................................................................................................

Mailing address  ...................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................

861 Serial number ................................................................................................................
Extra cards  ..........................................................................................................................

Dealer who supplied it  .........................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................

Comments

Meridian Audio Limited , Stonehill, Stukeley Meadows, Huntingdon, Cambs, PE18 6ED, England
Tel: +44 1480 434334 Fax: +44 1480 432948 Web: http://www.meridian-audio.com

Meridian America Inc. , 3800 Camp Creek Parkway, Building 2400, Suite 112, Atlanta GA 30331
Tel: +1 (404) 344-7111 Fax: +1 (404) 346-7111


